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About Durametric

Durametric Software Inc. is comprised of software engineers and automotive enthusiasts alike. As
automotive enthusiasts, we understand the value of solid, effective tools in the workshop. As engineers,
we work hard to develop intuitive, comprehensive software and robust hardware to create an overall
package that meets our customers’ high standards — and ours.

The Durametric tool for Porsche is a hardware and software-based tool. The software program installs
and runs on your Microsoft Windows computer and manages communication between you and the car.
The hardware consists of one or more cables that connect between your computer and the car and
facilitates communications between the program and the car. With a primary focus on diagnostics, the
tool provides communications with the various systems to read, display, and clear trouble codes, reset
service reminders, activate system components, display and capture live values, and alter code settings.

Included in the Kit

Depending on the product kit you purchased, some or all of the following cables will be included with
your package: standard interface cable, early-model adapter cable, 50’ extension cable, racecar adapter
cable. We do not include a software installation CD with your order. You must download and install the

Durametric software directly from the Durametric web site, www.durametric.com.

9 %

Standard interface cable Early-model adapter cable

50’ extension cable Racecar adapter cable
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Product Variations

Durametric offers three varieties of diagnostic kits for Porsche: Enthusiast, Professional, and
Professional Racing. With the exception of coding and command console features, all kits provide the
same diagnostic capabilities across the same range of standard-production cars. The coding and
command console features are available with the Professional kits only. Only the Professional Racing kit
supports Porsche factory racecars in addition to standard-production cars.

* Enthusiast Kit: Intended for the private owner of Porsche, the Enthusiast kit comes complete
with one USB-to-ODBII standard interface cable. If purchased, your kit might also include the
early-model adapter cable with the nineteen-pin, early-model adapter cable.

The Enthusiast kit is limited to use on three cars managed by VIN. Durametric enforces this limit
by storing the car’s VIN in the memory of the cable. After you use the cable on three cars, it will
only continue to function on those three cars.

* Professional Kit: Intended for the service repair shop, the complete Professional kit comes with
one USB-to-ODBII standard interface cable, one 50’ extension cable, and one nineteen-pin,
early-model adapter cable. Variations to this kit also exist. You can use the Professional version
on an unlimited number of cars.

* Professional Racing Kit: Intended for service repair shops and Porsche racecar support teams,
this kit supports all diagnosable, standard-production Porsche models and Porsche factory
racecars. You can use this kit on an unlimited number of cars. This kit comes complete with one
USB-to-ODBII standard interface cable; one 50’ extension cable; one nineteen pin, early-model
adapter cable; and one racecar adapter cable.

How the Program Works

The completely redesigned Durametric program makes use of a new and innovative software platform.
The new software platform has three main components: 1) the “Framework” 2) the “CAR files,” and 3)
the “ECU files.”

The Framework is the core of the new software. It maintains control over all other components of the
tool including the user interface and communication with the standard interface cable and car. The
Framework gets information from the CAR files in order to reference control units associated with the
many different Porsche models. It gets information from the ECU files so it can communicate effectively

with those control units.

Each Porsche model comes equipped with a number of electronic control units. The CAR files are simple
XML files that list each possible control unit in a given model. The Framework uses the CAR files to
reference the Durametric ECU files.

The ECU files are XML files that contain control unit address information, unit ID and descriptions,
possible fault codes and their descriptions, activation options, and other ECU-specific details. The
Framework uses the information in the ECU files to interact with the control unit. The Durametric user
interface displays much of the information contained in the ECU file, such as available options and fault

code descriptions.
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With the introduction of this platform, Durametric can support more features on a greater number of
control units at a faster pace of release.

Installation

The following sections will guide you through a successful installation of the Durametric software.

Check System Requirements
The following is a list of the minimum system requirements for the effective use of the tool. Check to be
sure your system meets or exceeds these requirements and has the prerequisite software installed.

* Windows XP, Vista, or Windows 7 (All versions, including 32- and 64-bit versions)

¢ 1.8 GHz dual-core processor or faster

* 1 GB Memory (RAM)

* 1 GB available disk space

* Available USB 2.0 port (USB 3.0 not yet supported. Computers supporting USB 3.0 not
recommended.)

* Internet Explorer 6.0 or later

* Available Internet connection (required for program installation and updates)

* Screen resolution of 800x600 or greater

*  Microsoft® .NET Framework 2.0 or 3.5 sp1 (free download, not required for Windows 7)

* Adobe Acrobat Reader (for reading and printing documentation)

* Durametric Z”d-generation cable (sold exclusively since March 2008)

Install the Software
After you install the necessary supporting software you can install the Durametric software.

Using your Internet browser, go to www.durametric.com.

Select Downloads from the left column.
Select Version 6.
Install the Durametric cable drivers.

vk W R

Install the Durametric software program. If you do not have Microsoft .NET Framework 2.0 or
3.5 spl installed, the program will prompt you to install it before continuing.
6. When prompted with the security warning, click Install.

Upon successful installation of the software, you are ready to use Durametric.

Connect the Cables
WARNING: Do NOT use a power inverter to power your computer when using Durametric.

Depending upon the kit you ordered, you will have one, two, three, or four cables. Before starting the

Durametric program, connect the tool to your car as follows:

1. Switch on the car’s ignition.
2. If the caris a 2005 model or newer, turn on the hazard lights (emergency flashers).
3. Connect the OBDII-end of the standard interface cable to the diagnostic port on your car.
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a. If you purchased the 50’ extension cable, you can connect it between the male ODBII-
end of the standard interface cable and the car.

b. If you are working on early-model cars and have the early-model adapter cable, connect
it between the standard interface cable and car or between the 50’ extension cable and
the car.

c. If you are working on a Porsche factory racecar and have the Durametric Cup car
adapter cable, connect it between the standard interface cable and car or between the
50’ extension cable and the car.

4. Verify a steady green light on the Durametric cable indicating power from the car.
5. Connect the standard interface cable’s USB connector to the USB port on your computer.

Using Durametric
Durametric is equipped with many of the same capabilities and features of the Porsche factory tools.
The following sections guide you through the many features of the program to help you get the most

from your tool.

Start the Program
Connect the cables before starting the program. To start the program after its initial installation:

1. Click the Windows Start button.
2. Select All Programs |Durametric 6.

Upon starting the program, you will see the Durametric logo screen(s) of the main program.

Choose Vehicle

The first screen to appear after successful installation of the software is the Choose Vehicle dialog. Here
you can choose a car based on make, model, series, and year. Alternatively, you can choose a specific
control unit from the list of all supported control units found under the Individual Control Modules tab

of the Choose Vehicle dialog.
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Choose Vehicle @
Vehicles | ndividual Control Modules
Make Model Series Years
Porsche 911 964 1989-1954
Porsche 911 993 1994-1999
Porsche 911 996 1998-2005
Porsche 911 997 2005-2010
Porsche 928 928 1989-1995
Porsche 944 944 1989-1991
Porsche 968 968 1992-1995
Porsche  Boxster 986 1997-2004 |
Porsche  Boxster 987 20052010
Porsche  Cayenne 955 2008-2010
Porsche  Cayenne 955 2005-2006
Porsche  Cayenne 955 2003-2004
Porsche  Cayman 987 2005-2010
[7] Create work log for this session
l 0K l [ Cancel ]

Select a model or individual control unit from the Choose Vehicle dialog

Main User Interface

The main user interface now appears. When you select a model from the Choose Vehicle dialog, the
program displays a list of supported control units in the left-hand pane. If you select a single control unit
from the Individual Control Modules tab of the Choose Vehicle dialog, the software displays only that
control unit.

Double-click a control unit in the left-hand pane to reveal available functions for that control unit.
Alternatively, click the “+” sign next to any of the control units to reveal the same list of functions.

4/10/2012 ©Durametric Software Inc. Page 7 of 28



' Durametric Diagnostic Tool for Porsche version: 6.0.0.2 ( 2005-2009 Porsche 911 997 )

File  Functions Tools Help

GearﬂSeIectur FD ® ® ® ® ® @ diagnostic software
Stability Control

3 Al Whee_l Drive The application of this product can be dangerous. Please use it with care.
{3 Suspension This software makes it possible for you to influence or control a car’s electronic and mechanical systems. Your actions can

JEngine Module NE7 8. =
Transmission PD \ DuramEtrlc

{3 Tire Pressure therefore lead to severe personal injury or damage to property. For this reason, only persons that understand the
{3 Instrument cluster possible consequences of the use of this software, or persons specially trained in the use of this software, may use it.
{1 Electrical
{1 Airbag
{1 Seat Weight Sensor

+ 3 Steering Colurn Porsche, Boxster, Cayenne, Turbo, Targa are registered trademarks of Dr. Ing. h. c. F. Porsche AG

@ 3 Air Conditioning Durametric Software is not affiliated with Porsche in any way.
{3 Cornering Lights

{1 Gateway

-3 Left Door
-3 Right Door
#-C3 Convertible Top
Targa Roof

4 Park Assist

{ Seat Memaory
-3 hronameter

3 | [2)

e
Demo Mode Choose Module or Vehicle .:

1111}

Select from supported control units in the left-hand pane of the main user interface.

Screen Layout
The Durametric screen displays several key points of information, including software version, selected
model, status of the cable connection, and the control unit selected.
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Software Version Selected Model

' Durametric Diagnostic Tool for Porsche version: 6.0.0.2 ( 2005-2009 Porsche 911 997 )

File  Functions Tools Help

R N=AT= RN RN ENE
¢-L1 Engine Module ME7.5.1 -
t-L Transmission PDK \ Durametrlc

- Gear Selector PDK ® ® ® ® ® ® diagnostic software
¢~ Stability Control 9

H-L1 All Wheel Drive

’ The application of this product can be dangerous. Please use it with care.

£ Suspension This software makes it possible for you to influence or control a car’s electronic and mechanical systems. Your
#-_ Tire Pressure actions can therefore lead to severe personal injury or damage to property. For this reason, only persons that
¢-Cd Instrument cluster understand the possible consequences of the use of this software, or persons specially trained in the use of this
d-L Electrical software, may use it.

d-L Airbag

d-L0 Seat Weight Sensor

3
2
4
£
4
£
3
3
2
4
£
#-{J Steeting Column
- Air anditioning Porsche, Boxster, Cayenne, Turbo, Targa are registered trademarks of Dr. Ing. h. ¢ F. Porsche AG.
3
4
2
4
£
4
4
3
3
2
4
£

g Cornering Lights Durametric Software is not sffiliated with Porsche in any way.

d-L0 Gateway
d-L Alarm

f-Ld Front

d-{ Rear

¢-{ Left Door
¢-L Right Door
t-{d Convertible Top
¢-L0 Targa Roof
d-L0 Park Assist
d-L0 Seat Memory
t-{_J Chronometer

Porsche Professional Cable is attached Choose Module or Vehicle .

Cable Type and Connection Status Control Unit Selected

Menu options

* File
Start over — opens the Choose Vehicle dialog to select a different model
Open work log — opens a Browse window for the selection of a previously-saved work
log (see Work Log section for details)
o Open ECU file — opens a Browse window for the selection of a stand-alone ECU file.
Used by Durametric technical staff for troubleshooting purposes.
o Print —sends the current view of data to the default printer
o Print setup — not currently supported
o Exit—closes the Durametric program
* Functions
o Short test all modules— starts a check of all control units for fault codes
o Clear faults in all modules — used to clear all fault codes in all supported control units of
the selected model
o Refresh current view — used to request updated fault codes are live data from a control
unit
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e Tools

* Help

e}

Set workshop information — opens the Set Workshop Information dialog (see Set
Workshop Information section for details)

Tool information — opens the Tool Information screen that provides cable type, cable
status, cable serial number, and software / firmware version details
Logging

= Logging enabled — enables logging for troubleshooting purposes

= Send log to Durametric — opens the Send Communications Log screen (see Send

Log to Durametric section for details)

Check for update — uses an available Internet connection to check for software updates
(see Updating the Software section for details)
Language — used to change the text of the user interface to one of many supported
languages

Documentation — opens this guide in PDF format

Durametric WIKI — uses an available Internet connection to open the Durametric WIKI
pages that cover car-specific troubleshooting information and more

About — opens information about the program and the program version

Icons at the top of the Durametric user interface provide access to common functions. These include:

New — opens the Choose Vehicle dialog to select a new vehicle

Open —opens saved work logs

Print — print the current page

Print Setup — not currently supported

Refresh — refresh the current view

Short test all units — runs a brief test of all control units in the car to check for fault codes

Clear faults in all units — attempts to clear all fault codes in all control units of the car

Control Unit Functions

Each control unit supports one or more of several different functions. You can access these functions by

expanding the list under each control unit.
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" Durametric Diagnostic Tool for Porsche version: 6.0.0.2 ( 2005-2009 Porsche 911 997 )

File  Functions Tools Help
LSS IE RIS A
=R ] Engine Module ME7.5.1((ed

() -
----- *" Identification \DuramEtrlC

L@ Information - -
@ Fault Codes ® ® ® ® ® @ diagnostic software

----- @ Erase Fault Codes
..... 2 Actual Values

..... [~ Input Signals

..... « Ready Status

----- &° Activations

4% Coding

\ZJ System Test

----- CommandConsol
BT nsmissioni[éﬁj
#-C1 Gea K
#

[

The application of this product can be dangerous. Please use it with care.
This software makes it possible for you to influence or control a car’s electronic and mechanical systems. Your
actions can therefore lead to severe personal injury or damage to property. For this reason, only persons that
understand the possible consequences of the use of this software, or persons spedially trained in the use of this
software, may use it.

Porsche, Boxster, Cayenne, Turbo, Targa are registered trademarks of Dr. Ing. h. c. F. Porsche AG
Durametric Software is not sffiliated with Porsche in any way.

®-d Stability Control

#-C All Wheel Drive

- Suspension

- Tire Pressure

- Instrument cluster
- Electrical

- Airbag

- Seat Weight Sensor
-3 Steering Column
@ Air Conditioning
- Cornering Lights M
(3 —— B

Porsche Professional Cable is attached Choose Module or Yehicle .:

View of control unit functions
In order of appearance, these functions include:

Identification

The Identification function is available for each control unit and displays information such as part
number and supplier name.

Information

You can find the Information function under control units that support this feature. This option displays
information such as the VIN and assembly number.

Fault Codes/Shadow Fault Codes

Fault codes, shadow fault codes, their descriptions, and fault status information are included in the
display when supported by the control unit. The codes displayed are the same codes used by the factory
tool and can be directly referenced in the factory service manual or other reputable repair manuals.
Freeze frame details are included with supported engine control units. Freeze frame information
includes various operating and environmental data taken at the time the fault appeared. You can use
this information to aid in troubleshooting and to help resolve improper operation.

Control units store some faults for information-only purposes. In these cases, there is no repair action
necessary. Durametric indicates the difference between actionable faults and information-only faults
using two icons. The yellow circle icon with the exclamation point in the center indicates an information-
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only fault. The red circle icon with the exclamation in the center indicates an actionable fault. Refer to
your car’s service repair manual for more information on information-only faults.

| ®

Information-only fault indicator Actionable fault indicator

Erase Fault Codes/ Erase Shadow Fault Codes
To clear fault codes or shadow fault codes from the control unit’s memory, click on the Erase Fault
Codes or Erase Shadow Fault Codes option, respectively, for the control unit selected.

Alternatively, you can select to erase fault codes in all control units at once by selecting the Functions
menu option and selecting Clear faults in all units.

It is not possible to erase only one fault code. If faults remain after attempting to clear them, it indicates
the problem(s) causing the condition still exists. For example, if the fault you see is “Electrical fault,
oxygen sensor ahead of catalytic converter bank 2,” and you have not repaired the problem, you will not
be able to clear the fault.

Actual Values
With Actual Values, you can monitor live data values managed by the control unit. The available value
options are predominantly the same as those available in the latest Porsche factory tool.

Upon selection of a value, the data automatically appears in graph and/or in digital format as seen
below. You can choose to view the data in graph format, digital format, or both, by selecting your
preference on the Options tab.
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' Durametric Diagnostic Tool for Porsche version: 6.0.0.2 ( 2005-2009 Porsche 911 997 )

File  Functions Tools Help

R o= = NS N EZNES

=-{3 Engine Module ME7|4 | | Available Actual Values | Activations | Options Hide Selection

""" ¢ Idenllﬁcgtlon Available Values Value Units Color ]
""" © Information DME supply voltage 12.04 v ‘
~[l Fault Codes [] Engine speed 1/min
""" @ Erase Fault Code [ Idle speed specified rpm 1/min
""" 12 Actual Values [] Loss adaptation idle %
""" | Input Signals [[] Engine load %
""" \? Ready Status [[] Altitude correction factor
& Activations | || LE7_tmhient nressure from DME 885 hPa hd
hPa W
DME suppl
»»»»» B CommandConso T T /
@ Transmission PDK 800 - 800
- Gear Selector PDK | | v
@~ Stability Control Ambient pressure from DME
- All Wheel Drive 6004 800
iu__l Suspension E g
@ Tire Pressure
- Instrument cluster 4007 4007 hPa
@3 Electrical ) )
-0 Airbag 2004 200 4
- Seat Weight Sensor
- Steering Column i i
i\\_J Air Conditioning 0= O ——
- Comering Lights - 0 LU 30 40
L B A Time (s)
< m >
Porsche Professional Cable is attached ME7381

Viewing live data in Actual Values
To use actual values:

Select a control unit from the left-hand pane.

Click Actual Values (found on supported control units only).

In the right-hand pane under the Available Actual Values tab, select a listed value. Live values
will appear in graph and digital format automatically.

Note: Avoid selecting more values than needed. The Actual Values process is very resource intensive for
the control unit and the computer running the program. Selecting more options than necessary can
seriously degrade program performance. For this reason, the program is limited to the selection of ten
values. Also, note that sample rates vary by control unit. The newest control units sample much faster
than earlier versions. Faster sampling rates require more computer resources.

There are three tabs found on the Actual Values screen:

e Available Actual Values
* Activations

¢ Options

The tabs pane can be hidden to view a larger graph. To hide the tabs pane, click the Hide Selection link.
To reveal the tabs pane, select the Display Selection link.
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Available Actual Values | Activations | Options Hide Selection
Available Values Value Units Color i
[] DME supply voltage v
[] Engine speed 1/min
[] 1dle speed specified rpm 1/min
[] Loss adaptation idle %
[] Engine load %
[] altitude correction factor
| [ Ambient nressire from DE hPa i

Select the desired actual value(s) under the Available Actual Values tab

The Available Actual Values tab gives you a list of values supported by the control unit. Select a value or
multiple values to request the data from the control unit. Data sampling begins automatically.

The Activations tab provides an easy access point to activate vehicle components that the selected
control unit manages. You can use the activations to affect the Actual Values data output, giving you
truly comprehensive troubleshooting capabilities and greater ease of use. Read more about activations
under the Activations section of this document.

| Available Actual Values |; Hide Selection
A/C compressor [ start ] [ stop ] A
Fuel evaporative valve [ start ] [ stop ] -
Engine compartment purge fan [ start ] [ stop ]
AlR pump [ start ] [ stop ]
Exhaust flap [ start ] [ stop ]
| Intake nine switchaver 1 [ 1 [ 1 L]
Using the Activations tab, you can activate supported components
The Options tab provides access to editable settings of the Actual Values feature.
Available Actual Values | Activations | Options | Hide Selection
Display Type Refresh Rate Export Data Other
(('2 E.OT Ti[g)i.tallandogrlaph Fast J Slow Eilse\j can be saved to excel or Stop / Start
_) Digital Display Only
O Graph Only Clear Samples

[E] Show multiple graphs Faster sampling rates will create large files

[] Show graph toolbar

Save Settinas
Recall Settinas

The Options tab provides access to editable settings

Options tab settings and controls include the following:
* Display Type
o Both digital and graph — shows data values in analog (graph) and digital format
o Digital display only — shows data values in digital format only
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Graph only — shows data values in analog (graph) format only
Show multiple graphs — shows each selected value on separate graphs
Show graph toolbar — opens a toolbar to aid in viewing graph details (see Graph Toolbar
section below)
* Refresh Rate — controls the sampling rate of the program and helps balance the need for greater
detail with the available resources of the computer and control unit being sampled
* Export Data — used to export sampled data values to a Microsoft Excel®* spreadsheet or
comma-separated values (CSV) file for further analysis
*Requires the Microsoft Excel application
* Other
o Stop / Start — controls sampling by stopping the process if it is running, or starting the
process if it is not running
Clear samples — clears previously sampled data values from memory
Save settings — saves to an XML file the current settings based on the control unit
selected
o Recall settings — opens a Browse window to select an XML file containing previously
saved settings

The graph toolbar provides additional controls for use with Actual Values graphs.

XA HBERS

Actual Values graph toolbar

From left to right, the graph toolbar includes:

* Crosshairs — used to hover the mouse over a graph position to see the exact values of a point

* Zoom in/out — used to alternately magnify or diminish an area of the graph to show detail. Left-
click and drag the mouse over the section you want enlarged.

* Zoom out all — used to zoom the graph back to full size

* Stop —used to stop sampling data values to view an event more closely

* Save - captures the current graph view to a graphic file

* Export data — saves sampled data values to a plain text file

* Page setup — portrait / landscape orientation settings for use with Print

*  Print preview — displays preview of screen details to be printed

* Print — captures and sends a picture of the current graph to an available printer

Input Signals

Similar to Actual Values, Input Signals convey the status of monitored components of the car. Unlike
Actual Values, however, Boolean values represent the status of Input Signals. For example, Input Signals
will typically have values such as Open / Closed, On / Off, or Yes / No. Along with actual values, input

signals can help you understand your car’s condition and help troubleshooting problems.
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' Durametric Diagnostic Tool for Porsche version: 6.0.0.2 ( 2005-2009 Porsche Boxster 987 )

File  Functions Tools Help

ReR=N1= RN A IE R

=+ Engine Module ME7/~|| Bosch Digital Motor Electronics Motronic 7.8.1
--¢” | |dentification i
----- @ Information Input Signals
-] Fault Codes Input Signal Status
""" © Erase Fault Codd | | Fullload recognition open
""" & Actual Values Idle recognition closed
""" [=] Input Signals A/C request open
----- « Ready Status Start enable switch open
----- &° Activations Stop light switch open
453 Coding _ || Stop light switch open
- System Test Immobilizer active
..... B CommandConso Cruise-control readiness on
#-3 Transmission PDK Clutch switch Not actuated
-3 Gear Selector PDK Cruise-control - store/accelerate Not actuated
w-C Stability Control Cruise-control decelerate/resume Not actuated
@~ Suspension
@ Tire Pressure
@~ Instrument cluster
- Electrical
- Airbag
- Seat Weight Sensor
#-{J Steeting Column
@ Air Conditioning
- Comering Lights
-0 Gateway ™
‘i] . 1l | ‘l‘
Porsche Professional Cable is attached ME781 .:

Ready Status

Ready status, or “readiness,” is an indication by the car’s on-board diagnostics (OBD) of the status of
several emissions monitors. Required on all USA cars since 1996, the readiness monitors check the
emission control system and its components. If the emission control system is not “ready,” the car
cannot legitimately meet emissions test standards.

Several factors can cause a vehicle’s ready status to be “not ready.” Some factors include:
e Recent fault code clearance
e Recent battery disconnect
e A pending problem with the emission control system

To meet readiness conditions, you must drive the car through a specific drive cycle. The drive cycle
varies by make and model and includes driving through a range of conditions, engine speeds, and loads.
Check your service manual and local emissions requirements for details.

Activations

The Activations option allows you to start and stop supported components within the car for
troubleshooting purposes. The tool supports components ranging from injection valves to windows and
door locks. For example, to confirm all indicators of the instrument cluster function properly, you can
use Activations for that control unit to turn them on for test purposes.

To activate supported components:

1. Select your model.
2. Select a control unit that supports activations.
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3. Select Activations.
4. Click the Start button found to the right of the components listed in the right-hand pane.

Warning! Use Activations options with caution and only with complete knowledge of their function. For
example, it is not a good idea to activate the coolant shutoff valve of a hot car for risk of damaging the

engine.

Coding

Available in the Professional kits only, the Coding option provides a way to back-up, restore, and change
settings within supported control units. For example, you can save the settings of an old control unit you
must replace and restore those settings to a new control unit. Durametric relies on internal part
numbers and metrics to ensure you do not restore settings to unintended, incompatible control units.
Coding options on supported control units vary.

To backup control unit settings:

Select a model.

Select a control unit that supports coding.

Select Coding.

Review the warning statement.

If you acknowledge the warning statement, click / understand the risks (proceed with coding).
On the Backup / Restore tab, click the Backup button.

o vk wnN e

The Save As dialog appears. The program uses an XML file to save the backup settings. By default,
the program names the file the same as the selected control unit and saves the file to the My

Documents (or Documents) folder.

7. Save the XML. Note the save location and filename for future reference.
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Save As ? r)?‘;

Savein: | (L) My Documents ;v] 3 e @

:2
-
My Recent
Documents

@

L§

Desktop

My Documents |

| |

o

My Computer

i ‘ \' >

":;l File name: PASH. x| \VI
> S
My Network | Save as type: Coding Files ‘v|

Save As dialog seen during Coding backup process

To restore saved control unit settings:

Select a model.

Select a control unit that supports coding.

Select Coding.

Review the warning statement.

If you acknowledge the warning statement, click / understand the risks (proceed with coding).
On the Backup / Restore tab, click the Restore button. The Open dialog appears.

Browse to the location of your backup files.

Select an applicable backup file.

W N A WN R

Click the Open button. The program then restores the settings to the control unit.
To edit control unit settings:

Select a model.

Select a control unit that supports coding.

Select Coding.

Review the warning statement.

If you acknowledge the warning statement, click / understand the risks (proceed with coding).
Select the Coding tab. Editable options will appear.

Ny ks wNR

Edit the settings as necessary. Settings changes take effect when you move the cursor to
another field.
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Coding
!Wérning | Backup a‘vl?e-sfore]' Coding ‘

Vehicle

Version
Transmission Type
CAN

‘99? Cc2
vSpon
‘VManualr

E)E]

L3

=3

Deactivated
Activated

An example of the Coding dialog

System Test

Engine control units in some models support a system test. The engine unit’s system test runs a check of

the engine’s various emissions components. During the test, the cycle flags may be cleared and set

again. If the test does not complete, the cycle flags will not be set. Most system checks require you to

meet specific conditions before the test can begin.

System Test

Select Test

¥ =Nottestedyet ¥ =TestNotPassed ¥ =TestPassed

Description
¥ Knock Control
¥ 02 Sensor Heater Behind Catalytic Converter

¥ 02 Sensor Circuit Slow Response Sensor 2
¥ Oxygen sens. aging ahead of cat. converter

¥ Basic Mixture Adaption

¥ Secondary Air System

¥ Catalytic Converter Efficiency
¥ Tank Vent Valve

Ag 02 Sensor Readiness Behind Catalytic Converter

¥ Dyn. test of ox. sen. ah. of catalytic converter (LSF)

The System Test dialog

The system test in Durametric has two modes of operation: single test or the advanced, simultaneous

tests. On the Select Test screen (seen above), you can select to run a single test. Otherwise, click the

Advanced button to run all tests and see results simultaneously.
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Commands

Many control units support the ability to receive single, non-repetitive requests to alter the status of
settings. Separate from coding changes, the Commands feature includes such control unit requests as
adaptation resets. On many models, you will use the Commands feature of the Instrument Cluster to

reset the service interval.
To use commands:

Select a model.
Select a control unit that supports commands.

Select Commands.

P wnN e

Click Send adjacent to command you want to send to the control unit.

Instrument cluster
Commands

Reset service interval display © Send
Reset Send

Click Send adjacent to the command you want to send to the control unit

Command Console

Available in the Professional kits only, the Command Console is a means to send low-level, manually
configured requests to a control unit and see the response. Intended only for those who understand the
low-level communication language of Porsche control units, you can use this feature for a deeper level

of troubleshooting.

Reset Service Reminders
Late-model cars utilize service intervals and reminders on the instrument cluster for oil service and
inspections. These cars display the reminder when service is due. You should reset service intervals upon

completion of the appropriate maintenance.
To reset the service reminder:

Select your model.
Select the instrument cluster.
Select Commands.

P wnN e

Click Send next to the service interval option.
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' Durametric Diagnostic Tool for Porsche version: 6.0.0.2 ( 2005-2009 Porsche 911 997 )

File  Functions Tools Help
QTR0

#-C3 Engine Module ME7 A/ | Instrument cluster
- Transmission PDK

®-d Gear Selector PDK Commands

#-d Stability Control

&5 All Wheel Drive Reset service interval display (7]
®-Cd Suspension

®- Tire Pressure Reasat

=3 Instrument cluster
----- ¢ |dentification

----- @ Information

-{7]] Fault Codes

----- @ Erase Fault Code
----- 2 Actual Values

R Cormmands |

----- B CommandConso
- Electrical

®-d Airbag

@-{J Seat Weight Sensor

i- Steering Column
-3 Air Conditioning
#-d Cornering Lights
w-C Gateway

\<l| = 1} | [

)

KOMEI .

Find service interval resets under the Commands option of the instrument cluster

Short Test
The tool is capable of running a short test on any model selected. The short test scans the car for

supported control units and queries each control unit found for trouble codes. Upon completion of the
scan, the program returns a list of control units included in the search and any faults found. The
program groups the trouble codes it finds by control unit and includes a brief description of the fault to

aid in troubleshooting.
To perform a short test:

Select a car model from the Choose Vehicle dialog.
Select any equipment variations.

Select the Functions menu option.

Click Short test all modules.

P wn e

Set Workshop Information
Included with the Durametric Professional Kit only, you can customize the software for your business

through the Set Workshop Information feature. With this feature, you can enter details such as your
business name, address, phone number, and company logo. The information will appear on screens

within the software and printed pages.
To set workshop information:

1. Select the Functions menu option.
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Click Set Workshop Information.

Enter shop name, address, phone number, path to your logo, and dealer code (if applicable).
Select any of the available display options.

Click Save.

Close and re-open the program to affect changes.

' Durametric Diagnostic Tool for Porsche version: 6.0.0.2 ( 2005-2009 Porsche 911 997 )

File

RN R RN

Functions  Tools  Help

Select vehicle or control module KOMBI .

Workshop Information

Shop Name Durametric Software Inc.
Wddress 1 61451 SE Parrell Road
Address 2

City, State Zip Bend, OR 97701

Phone §88-854-5523
Logo Path C:\Documents and Settingshowen'Temp E]
Dealer Code

Display workshop information on faults window
Display workshop information on summary window

[V]iDisplay workshop information on information windows

Save

Workshop Information edit screen

Work Log
The Durametric tool includes a work log that can save Identification, Information, Fault Code, and Short

Test information. You can use this feature to review diagnostic and work history data after using the

tool. The program saves work logs as HTML files so you can share the information with others as

needed.

To Enable the Work Log

1.

2.
3.
4

Open the Choose Vehicle dialog.

Select a model.

Select the Create work log for this session option.
Click OK.

The program creates a work log using the date and time of the diagnostic session. The program creates a

separate work log each time you start the program.

4/10/2012 ©Durametric Software Inc. Page 22 of 28



To Review a Work Log
1. Select the File menu option.
2. Click Open Work Log.
3. Select a log from the list based on the date / time stamp.
4. Click Open.

When saved, work log files are marked automatically with a date / time stamp for easy reference.

Updating the Software
You can check for software updates direct from the Durametric program. This process requires an
existing Internet connection.

To check for software updates:

1. Open the Durametric program.
2. Click on the Tools menu option.
3. Select Check for updates.

This action opens your default Internet browser to the www.durametric.com/downloadv6.aspx page.

Compare the installed version on your computer with the current release indicated on the Download
page. You will find your software version at the top of the Durametric program screen.

To update your software:

1. Close the Durametric program.
2. Uninstall the version of Durametric currently installed.
3. Click the Durametric Software Program link on the Durametric website.

Updating the Cable Firmware

The standard interface cable manages communication between the Durametric software and your car’s
control units. Periodically, Durametric releases firmware updates to ensure our cables continue to
perform as expected across various models and software versions.

To update the firmware:

4. Click the Tools menu item.
5. Click Tool Information from the menu.
6. Click the Update Firmware button.

Updating the firmware takes approximately 45 seconds. The standard interface cable must remain
connected to the computer for the update to occur. Do not disconnect the cable during the firmware
update.
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Porsche Diagnostic Connector Locations
The location of diagnostic connectors on most cars is under the dash on the driver’s side. Here are some
common connector locations:

* 944/968 — Under the dash on the passenger side
* 964 — On the passenger’s side kick panel behind a round cover
e 993
o 1994 — 1995 — For models with the 19-pin round connector, it is located on the
passenger’s side kick panel behind a round, plastic cover
o 1995 -1998 — For models with the 16-pin OBDII connector, it is located on the driver’s
side of the center console behind a round, plastic cover
e 996 /986 — Under the dash on the driver’s side
e 997 /987 — Under the dash on the driver’s side

* Cayenne — Under the dash on the driver’s side behind a hinged, plastic cover

Factory Racecars
You can access information in Porsche factory racecars using the Durametric Professional Racing kit. Do
to so:

1. Select a model (996 / 997).
2. Select the appropriate Cup / RSR engine option.

The list of actual values for racecars covers most models, but not all actual values are available on all
cars. There might be actual values listed in Durametric that the car does not support.

You can find the data link connector on racecars on the passenger’s side of the roll-cage. Porsche Cup
cars before 2001 have a normal data link connector and do not need a special cable.
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Common Problems and Solutions

Here is a list of some common problems and solutions.

Software will not install * Confirm you have an internet connection

* Confirm your computer meets the minimum system
requirements

* Confirm there are no software installation
restrictions at the firewall

* Confirm you have appropriate rights to install
software (especially important on Windows Vista)

* Install (re-install) Microsoft .NET Framework 2.0 or
3.5spl

Software will not start * Restart your computer

* Confirm your computer meets the minimum system
requirements

* Reinstall the software from www.durametric.com

Cable not recognized by the * Confirm Windows Device Manager “sees” the cable
software when connected

*  Confirm Durametric USB cable drivers are installed
* Confirm the cable is a genuine Durametric cable

Initialization failure when trying to * Cable is not securely connected

connect to a control unit * K-line short to ground or Battery+

* CAN bus has entered “sleep” mode (MY2005+)

* Control unit is faulty

¢ Control unit not present

* Control unit is different than the one selected in the
Durametric software

* Control unit not properly supported — contact
technical support

Cable LED turns red * Indicates an electrical short
o Between K1 or K2 and B+
o Between K1 or K2 and Ground
* Check for appropriate continuity between the
ground, power, and communication pins at the
diagnostic connector at the car
* Check for electrical shorts by clicking Tools = Tool
Information when connected to the car

Cable LED won'’t turn green * Confirm there is a secure connection between the
Durametric cable and the car

* Confirm the car’s ignition is in the ‘on’ position

* Confirm the car’s battery is fully charged or a back-
up power supply is correctly attached

*  For CAN bus based cars, awaken the CAN network by
switching the key to ‘off’ and then to ‘on’. Confirm
the check engine light appears on the instrument
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cluster display. Keep the CAN bus ‘awake’ during
diagnostics by turning on the emergency flashers
Check for appropriate ground (pins 4 & 5) and 12+
Volts (pins 1 & 16) at the diagnostic connector of the
car when the ignition is on

“Cable not plugged in” message

Confirm the cable is securely connected to the USB
port on your computer

Confirm there is power from the car to the cable and
the LED on the cable is steady green

Confirm Durametric USB cable drivers are installed
properly — reinstall cable drivers if necessary
Confirm Windows Device Manager “sees” the cable
when it is connected

Confirm the cable is a genuine Durametric cable

Cannot update the software

Confirm there is an update available

Confirm you have an internet connection on the
computer that runs the Durametric software
Confirm you have the appropriate administrative
rights to install software

Uninstall Durametric through the Windows Control
Panel and reinstall USB Cable Drivers and Durametric
Software Program from www.durametric.com

Module “failed to initialize”

Confirm the cable is securely connected to the car
and computer

Confirm the control unit exists in the car

Wiring problem in car to control unit (very common
in the 993 at the data link connector)
Electromagnetic interference: Confirm all stereos,
radar detectors, navigation equipment and
amplifiers are turned off while performing
diagnostics

Computer processer is too slow: See Computer
Performance Suggestions in this guide

Computer Performance Suggestions

Control units fitted to newer cars communicate at a fast 500 kbps (kilobits per second) and require

timing windows as small as 5 milliseconds. In this case, some computers might experience difficulty

connecting. Here are some suggestions to help improve the performance of your computer:

¢ Confirm the computer meets the minimum requirements for processor speed and memory (1.8

GHz dual-core processor or faster and 1 GB of RAM)

* Close all other programs during diagnostics

* Remove any CD / DVD from CD or DVD drive

* Connect laptops to power or change Power Management settings to maximum performance.

Most laptops will run at reduced processing speed when running on battery power.
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* Defragment the hard disc. When your hard disc is heavily fragmented, the computer must work
harder and therefore, runs slower.

* Temporarily disable anti-virus software. Some virus protection software can slow or stop the
communications ports.

Send Log to Durametric
Use this option only upon direct request of Durametric technical staff. Durametric does not respond to
unsolicited communications logs.

When working with Durametric technical staff, they may ask you to submit troubleshooting logs via the
Send Log to Durametric option. You will find this option under the Tools menu. An Internet connection is
required to send the information to Durametric.

To send a communications log to Durametric:

1. Click Tools | Logging | Enable Logging.

2. Restart the program.

3. Perform any processes or functions previously found to fail. This ensures the program captures
the communication details between the program and the car.

Send Communications Log | RemovesllLogs |

If you are having a problem please contact technical support before sending a log. This
form should not be used for contacting support.

SelectLog |[] 5/29/2009 4:17 PM
[] 5/29/2009 4:18 PM

Name |
Email

Year

Make
Model

VIN

Problem

[ Send Data ] [ Cancel ]

4. Select a log from the list. The program lists the logs in chronological order, based on the time of
creation.

5. Enter your name, email, and details about the car. Be sure to include a detailed description of
the problem.

6. Send the log by clicking Send Data.

4/10/2012 ©Durametric Software Inc. Page 27 of 28



Index

AbOUt DUFraMELIiC . .uuuereeeriiiiieieieieeeeeeeeeeeeeeeeeeeees 3
AcCtivations .....coocviiiiiic e 16
Activations tab.........ccceeennnnnn. See Actual Values
ACtUAl ValUEBS .ovvvveviiiicceeceeeee e 12
TaADS ettt 13
Available Actual Values tab..... See Actual Values
CableS. ..o 3
50’ extension cable ........cocvvveviiiiiiiiieiieeeee, 3
(000] oY [=To1 4 (o] o L3PPSR 5
Standard interface cable.......ccccccoeeiiiiiiinnnnnnn, 3
CARFIlES i 4
Clear faults in all modules.......cccovvveeiieeieieeeennnn. 9
Clear faults in all units .............ccccoeeeeevvvvnennnnn.. 12
(070 To [] - U PUUUUPNE 17
Settings Backup.....cccovvveeeeeeeeiiiiicciiirieeeeee, 17
Settings Edit......cccccoviiieieiieeeeiecreeeeee, 18
Settings Restore....cooovvvvvvviiiiiieiiiiciee e, 18
Command Console..........eevevvvrvrereriiiiiieeeeeeeenn, 20
CoOMMANAS ...ccoiiiiiiiieeeeeeeeeee s 19
Common Problems and Solutions.......c.ccc....... 25
Computer Performance........coccceeeeeeeeeeccccnnnnnns 26
Connector Locations ........c.ceeeviiiiiiiiieiciiieeeeennns 23
Control Unit FUNCLIONS.......cvvvvvveviiiieceeeeen, 10
Activations .....ccoeveeiiiii e, 16
Actual Values .....uveeeeeeiiicieieieeeeeiieeeeeeeeeeee, 12
(00 Te 11 = U USRURRN 17
Command Console..........uueveveveveeiiiiiieeeeennn. 20
COMMANAS ..ccooieeeieeeeeeeeeeere e 19
Erase Fault Codes.........cccevvvviiiririeiveneeennnnnnn, 12
Erase Shadow Fault Codes..........cccoevvvvvvnnnnen 12
Fault codeS...uuiiiiiiieiiiiiiiiiiiiiiiiiieeeeeeeevas 11
Identification.....cccooeeeeeeiiiiiiiiiiieeeeeeeeeea, 11
INFOrmMation ...ccceeeeeeeeeeeiiiiiiiiiiieeeeeeeeeeeaa, 11
Service reminder reset......... See Reset Service
Reminders
Shadow Faults Codes .....cccccevveeiiiiiiiiiniinnnnnn, 11
Short test .....uvvveveeeeeiiiiieeeeeeeenn, See Short Test
Digital format.........cccccuvvvreeeee.n. See Actual values
4/10/2012

©Durametric Software Inc.

ECU fileS coiiiiieeiieeeeee et 4
Erase Fault Codes......cccoveeeeeeiiiciiiiiiiiieeeeeeeee, 12
Erase Shadow Fault Codes ........ccccvveeeeeeeeeennn. 12
Factory Racecars ....ccovviieiviiiiiiiieciiiiiee e, 24
Fault Codes.....cooiuiiiiiiiieeee e 11

Freeze Frames....ccccovviiveiiiceniieceviiicee e, 11
FrameworkK ......ccccvviiieeeeee e 4
Freeze Frames.......ccoccveeeeeeeeeenn. See Fault Codes
Graph .ooccceciieeeeeeeeeee, See Actual Values
How the Program Works........ccccovvveeeeiieiiiinnns 4
[ol0] o YRR See Main Interface
Identification.......ccccveeeeeeeeiieeicceeeee e, 11
Information ......cccccvvviiieeeee e 11
Installing the Software

SeCcurity Warning .....ccceevvveevviuiennieeeeiiiieneeeeeennns 5
Main Interface

[CONS e 10

MENUS ittt 9
Optionstab ...cccccceeeeiicinninnenn, See Actual Values
Product Variations .........ccceeeevviiiieeeee e 4

Enthusiast Kit ....ccccovvvieeeeeieiiiieeeeee e, 4

Professional Kit ......ccccceeeeeeeeiiiiiiiiiiiieeeee e, 4

Professional Racing Kit...........cccccvvvvveeeneennnn. 4
Reset Service Reminders.........cccccvvveeeveeeeennnnn. 20
Screen Layout...ccoeiiciiiiiien e 8
Send Log to DUrametric .....ccceeeeeeeeeeccnvnnnnenennn. 27
Service Reminders

RESELS . ittt 20
Set Workshop Information............cccccuvvnneeee.n. 21
Shadow Fault Codes.......ccovveeeeeeieiiiiciinieeeen. 11
ShOrt TEST .. 9,20
System Requirements .......ccovvvvveeiiiieiviiienieeeeennn, 5
Troubleshooting...... See Common Problems and

Solutions
Updating the Cable Firmware .........ccccceeeenenn. 23
Version

Software.......cccovvveeeeeeeeennnnn, See Screen Layout
WOTK LOG c.eviiiiiieeeeee ettt ee e e 22

Page 28 of 28



